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Who we are
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Our Story
Since 1906, the American Alliance of Museums (The Alliance) has been 

helping to develop standards and best practices, providing advocacy 

and gathering knowledge for the entire museum community. 

A 501(c)(3) public charity, the Alliance is a member-based organization 

with broad-based departments and programs including the 

Accreditation and Museum Assessment Program, Museums Advocacy 

Day, AAM Annual Meeting & Museum Expo, Museum Magazine, the 

Center for the Future of Museums and AAM Press. The Alliance also 

offers professional development, publishes professional literature, and 

increasingly works internationally.

We believe Museums  

strengthen communities.  

They educate and inspire,  

nourish minds and spirits, 

and enrich lives.
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Knowledgeable  

Collaborative  

Creative  

Transparent  

Idealistic  

Courageous  

Innovative  

Credible   

Influential  

Inclusive  

United  

Thought Leaders  

Authoritarian  

Independent  

Traditional  

Private 

Elite  

Restrained  

Conventional  

Imposing  

Passive 

Exclusive  

Fragmented  

Information Providers

We Are More Than
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Beliefs
We believe Museums strengthen communities. They educate and 

inspire, nourish minds and spirits, and enrich lives.

We believe active participation in the global community  

and embracing international perspectives is central to  

our core mission.

We believe the museum experience is characterized by encounters 

with real objects and primary learning experiences, in a positive place, 

supported by scholarship and knowledge.

We believe collaboration is important to advancing the museum field. 

We are strengthened through relationships with people, museums, 

communities and other organizations.

We believe our strength lies in our diversity among the broad range 

of people and museums we represent.

Values
Integrity 

We value honesty and ethical behavior in all that we do. We  

are accountable and responsible for our decisions and actions.

Openness 

 We are committed to transparency in our operation and 

communicate truthfully about our efforts and activities.

Creativity 

 We envision what might be, encourage innovation, tolerate 

ambiguity, and understand that the risk of failure is inherent in 

the creative process.

  Courage 

We strive to do the right thing by being proactive, valuing 

criticism, accepting tension, and taking risks.

Inclusiveness 

We seek out and embrace diversity of participation,  

thought, and action.

Excellence 

We value the highest quality in everything we do and  

how we do it.
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Organization

Professionals

Support

Public

Audience segmentation
To effectively communicate how the Alliance can help all potential members, the targeted audience was segmented into three factions  

based on their similarities. The Alliance brand message can then be supported with a concise copy targeted directly to the needs  

of each individual group.

The audience breakdown is as follows and is prioritized within each segment:

∙ Museums  

∙ Corporate Sponsors  

∙ Grant Makers  

∙ Other Associations 

∙ Legislators/Policy Makers 

∙ Museum Professionals 

∙ Future Professionals 

∙ Media Professionals 

∙ Donors & Trustees 

∙ Museum Advocates & Volunteers 

∙ Researchers 

 

∙ Teachers & Educators  

∙ Patrons & Museum-goers 

∙ K-12 & Higher Education Students 

 

 

Organization Professionals Public
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Our beliefs
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Guidelines
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Visual references
The American Alliance of Museums identity uses several  

visual references as emotional touchstones for the viewer.  

The references are fairly abstract and the impact is subtle  

but strong.
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Weave pattern

Strength through unity, collaboration and cooperation. 

The structure is transparent, not hidden. The emerging 

pattern is contemporary and can be leveraged for other 

brand artwork.

Color

Introducing color infers diversity, collaboration and creativity. 

Allows for a wide palette to be used with the brand.
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Our logo
The American Alliance of Museums logo unites these concepts 

of group strength and diversity though the colorful weave design. 

The clean and uniform rounded corners and angled lines gives 

this mark a very contemporary feel.
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1X .5X.5X

.5X .5X

Clearance space
The width of the weave logo 1X is the basis for spacing the 

lockup. .5X is the minimum requirement for  

clearance space.
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The full color logo (regular or knockout) should be the version 

that is primarily used on all materials. Full black is available for 

faxes and gray is suggested for black and white jobs. The white 

knockout should be used when the logo is placed atop one of 

the brand colors.

01 Full color 

Logo variations  
& presentations
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02 Full color knockout 04 Gray 05 Black03 White Knockout
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Logo misuse
It can be easy to use the Alliance logo in an incorrect fashion. 

Here are several ways that the logo should not be used.

The logo may not be 

rotated or distorted.

A color logo must use 

the approved color array 

as described on page 28.
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All non-colored areas of 

the full-color knockout 

logo must be white.

The logo must not be 

placed over any photo  

or image

The full color knockout 

logo must not be 

placed on any colored 

background that is not 

PMS 3165.

A two-tone logo must 

have the gaps in place of 

the shadows.
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Champion Museums. Nurture Excellence. 

The Alliance tagline "Champion Museums. Nurture Excellence." 

projects a balance of the strength and openness that the brand 

embodies. Its brevity, directness, simplicity and timelessness 

reinforces the Alliance messaging. Logo is not required to 

appear with tagline.

Our logo  
with tagline
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.5X.5X

.5X.5X

Champion Museums. Nurture Excellence. 

.25X

1X

Logo and tagline 
clearance space
The width of the weave logo 1X is the basis for spacing the 

lockup. .5X is the minimum requirement for clearance space. 

The tagline is a .25X drop from the logo. The tagline is not to 

be altered or abbreviated under any circumstances. 
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The full color, sub-brand logo (regular or knockout) should be 

the primary version that is used on relevant materials. Full black 

is available for faxes and gray is suggested for black and white 

jobs. The white knockout should be used when the logo is 

placed atop one of the brand colors.

01 Full color 

Sub-brand logos
Primary treatment

Sub-brand with 
Two Lines

Sub-brand
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01 White Knockout 02 Gray 03 Black

Sub-brand with 
Two Lines

Sub-brand with 
Two Lines

Sub-brand with 
Two Lines

Sub-brand Sub-brand Sub-brand
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01 Full color 

The full color, sub-brand logo (regular or knockout) should 

be the version that is used —on relevant materials— where 

positioning with the Alliance is paramount . Full black is 

available for faxes and gray is suggested for black and white 

jobs. The white knockout should be used when the logo is 

placed atop one of the brand colors.

Sub-brand logos
Secondary treatment with 1 line

Sub-brand
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Sub-brand

05 Full color knockout02 Gray 03 Black 04 White Knockout

Sub-brand Sub-brand Sub-brand
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01 Full color 

The full color, sub-brand logo (regular or knockout) should 

be the version that is used —on relevant materials— where 

positioning with the Alliance is paramount . Full black is 

available for faxes and gray is suggested for black and white 

jobs. The white knockout should be used when the logo is 

placed atop one of the brand colors.

Sub-brand logos
Secondary treatment with 2 lines

Sub-brand with 
2 Lines
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Sub-brand with 
2 Lines

05 Gray02 Full color knockout 03 White knockout 04 Black

Sub-brand with 
2 Lines

Sub-brand with 
2 Lines

Sub-brand with 
2 Lines
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The full color, Accredited Museum emblem (regular or 

knockout) should be the primary version that is used on 

relevant materials. Full black is available for faxes and gray is 

suggested for black and white jobs. The white knockout should 

be used when the logo is placed atop one of the brand colors.

Accredited  
Museum emblem

01 Full color 
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02 Black 05 Full color knockout03 White knockout
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The logo may not be 

rotated or distorted.

A color logo must use 

the approved color array 

as described on page 

36-40.

A two-tone logo must 

have the gaps in place of 

the shadows.

It can be easy to use the Sub-brand logo's in an incorrect 

fashion. Here are several ways that the logo should not be 

used. Refer to page 29 for additional guidelines. 

Sub-brand  
logo misuse
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The black "Weave" logo and the AAM Press logo are 

the elements that need to be incorporated into Alliance 

published materials. 

Logo usage  
on Alliance 
published books

The AAM Press

01 Weave logo

02 AAM Press logo 
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Alliance "Weave" logo 

must be placed centered 

at bottom of the spine.

Minimum spine width: 0.5"

1X .5X.5X

.5X

BOOK TITLE AREA

The AAM Press

The AAM Press logo must appear 

below book title on inner title page. 

The placement should mimic the 

proportions shown above.

The Alliance weave logo must be placed at the bottom 

of the book spine. The spine must have a width of 0.5" 

wide or larger. If the spine is narrower than 0.5", the 

Alliance weave logo must not be used.
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Business card layout
Format is standard US business card, 3.5” x 2” inches. There is 

a front and back design to the card. The back side is identical 

across all cards.
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Business card front
The information always follows a uniform layout.  

The order should be as follows:

1. Name 

2. Title 

3. American Alliance of Museums 

4. Email 

5. Phone/Fax 

6. Address 

7. Web address

Ford W. Bell, DVM
President

American Alliance of Museums 

fbell@aam-us.org 

T 555.555.5555 (direct)  |  F 555.555.5555

1575 Eye Street NW, Suite 400 

Washington DC 20005 

www.aam-us.org

0.3125“

0.625“

0.625“

All elements are 

centered vertically

Realist Bold | 10pt | 12 pt Leading

Realist Bold | 8pt | 9.6 pt Leading

Realist Semi-Light | 8pt | 11 pt Leading

Champion Museums. Nurture Excellence 

All elements are centered horizontally.

1.75"
0.5"

0.75"

0.175"

Realist Semi-Light | 9pt | PMS Cool Gray 4

Business card back
The back side of the business cards consists of the Alliance logo 

and the "Champion Museums. Nurture Excellence." tagline.

Realist Bold | 8pt | 16 pt Leading

Realist Bold | 8pt | 11 pt Leading
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The letterhead has a clearly defined layout. The logo also has a 

fixed location, as do the sender reference in the header and the 

complete corporate data in the footer.

Letterhead layout
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Ford W. Bell, DVM

President

fbell@aam-us.org 

T 202.289.9110 (direct)  

1575 Eye Street NW, Suite 400  |  Washington DC 20005  |  T  555.555.5555  |  F  555.555.5555  |  www.aam-us.org

0.5“

0.5“

0.5“

2“

0.5“

Realist Semi-Light | 8pt | 11 pt Leading

Realist Bold | 8pt | 11 pt Leading

Realist Bold | 10pt | 12 pt Leading

Realist Bold | 9pt | 12 pt Leading

Realist Semi-Light | 9pt | 12 pt Leading

2“Header
The sender reference always follows a uniform layout.  

The order should be as follows:

1. Logotype 

2. Name/Position/Email/Phone (Executive stationery only)

Footer 
The sender information always follows a uniform layout.  

The order should be as follows:

1. Street address 

2. City/State/Zip 

3. Telephone 

4. Fax 

5. Website address

Realist Bold | 9pt | 12 pt Leading
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Format is standard #10 envelope layout. Consists of very 

simple Alliance branding.

#10 envelope layout
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0.3125"

0.3125"

Envelope front
The information always follows a uniform layout.  

The order should be as follows:

1. Alliance logo 

2. Address

1.75"
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Watermark use 
The watermark should only be used in conjunction with 

the Alliance logo as a small, tertiary detail acting only as an 

aesthetic layer to photography, digital and collateral pieces. 
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Photography 

02 Gray 

Web 

01 White knockout 

Collateral  

02 Gray 40% opacity

Join us for the PRAM Mid-Atlantic Summit with Donna J. 

Keren, senior vice president for research & analysis from 

NYC & Company discussing "Understanding Cultural 

Tourists and Cultural Audiences" and new survey 

information about the decision-making process of 

cultural tourists visiting our region. George Wachtel, 

president, Audience Research & Analysis presents 

"Matching Research Methods to Marketing Goals" and 

will discuss the latest research tools to help understand 

and track visitors and potential visitors.

The program will begin with a viewing of Monet's Garden. 

The New York Times says "The first step in is a stunner."

Program concludes with light refreshments and 

networking with colleagues.

An optional, informal dinner will follow at Docks Oyster 

Bar in Manhattan (20 min from NYBG) for those looking 

for additional networking opportunities and a chance to 

discuss the topics from the summit. This dinner is not 

included in the registration price. Please RSVP to 

Grace Rapkin by May 29.

For directions to The New York Botanical Garden, 

visit nybg.org.

2012 PRAM Mid-Atlantic 

Regional Summit

05/30/2013

Registration 

Information

AAM Member: Free

Register 

Today

Non-member: $90

(includes a one-year 

Professional member-

ship to AAM)

Contact Us

Follow us on Twitter

Find us on Facebook

Copyright Statement

Privacy Policy

Terms of Use

American Alliance of Museums

1575 Eye Street NW, Suite 400, Washington DC 2005

202-289-1818

01 White knockout 02 Gray 03 Gray 40% opacity 04  Full color 3% opacity (background) 

Only use placed over PMS 3165 and oversized so that 

the logo is viewed purely as texture. Use sparingly.

42
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Color usage
The American Alliance of Museums color palette is expansive and 

can be used to express a variety of emotions. Combining these 

versatile colors correctly is key to maintaining a cohesive brand.

PMS 3165
This rich blue-green tone is the core color of the Alliance. It is 

stable and complex and soothing to the eye. It pairs well with any 

of the other brighter colors in the palette. Any greys should be 

converted to white before being placed atop this color.
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Complete palette

Primary Secondary

328 c

C100 

M0 

Y45 

B32

R0 

G127 

B123

3165 c

C100 

M0 

Y28 

B65

R0 

G83 

B94

3425 c

C100 

M0 

Y78 

B42

R0 

G112 

B74

347 c

C100 

M0 

Y86 

B3

R0 

G161 

B96

3272 c

C100 

M0 

Y44 

B0

R0 

G170 

B166

1807 c

C0 

M100 

Y96 

B28

R181 

G18 

B27

1797 c

C0 

M100 

Y99 

B4

R227 

G27 

B35

173 c

C0 

M69 

Y100 

K4

R232 

G109 

B31

021 c

C0 

M53 

Y100 

K0

R247 

G142 

B30

cool gray 

04 c 

C0 

M0 

Y0 

K24

R201 

G202 

B204

blackblack 

90%

black 

65%

Grays

Our colors
A wide variety of colors make up the Alliance brand. The cooler 

blues and greens make up the core palette while the hotter, 

punchier reds and oranges are thrown in to add some punch and 

liveliness. The grays can be used sparingly in conjunction with 

either of the palettes. No color should be tinted.
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PMS 3272 PMS 347 PMS 021 PMS 1797

PMS 328 PMS 3425 PMS 173 PMS 1807

The top row of colors are the main highlight colors of the Alliance. The bottom row of darker 

shades are to be used in conjunction with it's top row counterpart as an accent, as has been 

done in the Alliance logo. In most executions, the majority of the color palette should stick to 

the cooler end of the spectrum. The warmer colors should be used conservatively and only 

used to add punch to the placid tones of the blues and greens.

cooler warmercool warm

45
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Realist Light

Realist Semi-Light

ABCDEFGHIJKLMNOPQRSTUVWXYZ

abcdefghijklmnopqrstuvwxyz

0123456789

ABCDEFGHIJKLMNOPQRSTUVWXYZ

abcdefghijklmnopqrstuvwxyz

0123456789

Realist Bold
ABCDEFGHIJKLMNOPQRSTUVWXYZ

abcdefghijklmnopqrstuvwxyz

0123456789

Realist Narrow
ABCDEFGHIJKLMNOPQRSTUVWXYZ

abcdefghijklmnopqrstuvwxyz

0123456789

Our fonts
The American Alliance Museum identity is clean, refined, and lively. 

Typography is a vital part of that delicate balance. Realist is the 

typeface used to build the identity. Open Type Version (OTP) only. 

For smaller copy (such as body copy) Realist Narrow should be used. 

For web usage when Realist is not available, Arial should be used. 

Realist and Realist Narrow are available from MartinPlusFonts.com.
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Typography usage
To ensure that you have a consistent type treatment across 

many documents follow these style rules.

Headline

Subhead Line

Introduction copy block sed que omni to 

tem el ima porum suntiatae event adissi 

con eostem landita similic illest.

Body copy block. Velit volum andelen imollaut in corion 

platquidemo quatur as quat et ature nulparum cuptatem.

Sample body copy block with emphasis and usage of italics. 

Llique odi restiam sed que omni to.

Caption/Call Out copy block. Restiam sed que omni to 

tem el ima porum suntiatae event adissi con eostem.

Legal copy block. Henistias volestrum simagnis volupta net, te quaectis eniet eturit, si 

volupta tusam, optas quo to et quo ium quias.

Name. John Doe
Position/Title

American Alliance of Museums  

1575 Eye Street NW, Suite 400, Washington DC 20005 

T 202.999.9999 (direct)  |  F 202.289.6578  |  www.aam-us.org
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Print/Advertising
Headlines. Realist Light with Open Type Stylistic Set 1. Color 

preference is for one of the cooler brand colors (PMS 3272, 328, 

347, or 3425) but may depend on the color make-up of the page. 

This example is 30pt size, 34pt leading, and a 0.185 inch space 

after the line.

Subhead. Realist Bold with Open Type Stylistic Set 1. Color 

preference is same as headline (PMS 3272, 328, 347, or 3425) and 

also may depend on the color make-up of the page. This example 

is 20pt size, 24pt leading, and a 0.1 inch space after the line.

Introduction. Realist Light. Color preference is for Black 65% but 

can be a knockout if the background makes the copy illegible. This 

example is 14pt size, 21pt leading, and 0.1875 inch space after the line.

Body Copy. Realist Narrow Light. Color preference is for Black 

65% but can be a knockout if the background makes the copy 

illegible. This example is 11pt size, 15pt leading, -10pt tracking and 

0.1875 inch space after the line.

Body Copy emphasis. Realist Narrow Bold. Only if style 

regulations require italics instead of bolding should a 10° slant be 

added to the relevant text-weight copy.

Caption/Call Out. Realist Light. Color preference is for PMS 328 

but can be a knockout if the background makes the copy illegible. 

This example is 11pt size and 15pt leading.

Legal. Realist Narrow Light. Color preference is for Black 65% but 

can be a knockout if the background makes the copy illegible. This 

example is 8pt size, 11pt leading and -10pt tracking.

Stationary
Name on business cards. Realist Bold with Open Type Stylistic 

Set 1. Color preference is for one of PMS 328. This example is 12pt 

size and 14.4pt leading.

Position/Title. Realist Bold. Color preference is same as the name 

on the business cards: PMS 328. This example is 11pt size, 13pt 

leading, and a 0.02 inch space after the line.

Stationery copy, e.g. address & contact info. Realist Semi-Light.  

Color preference is for Black 90%. This example is 10pt size  

and 13pt leading.

American Alliance of Museums 

Naming Convention
The Alliance. When using an abbreviation of name of the 

organization, use "The Alliance" wherever possible, instead of  

AAM. The Alliance carries a stronger emotional benefit than is 

implied using the acronym.

48
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Step 1 

Open the Adobe Illustrator file titled 

AAM_argyle.ai (1a). Using the 

Alliance color palette, change the 

colors of the individual diamonds 

to create color arrangement. The 

arrangement should contain mostly 

cool colors (85 - 100%) and should 

progress from cooler to warmer 

colors from left to right (1b).

Step 2 

Using the type tool, type out 

your phrase using Realist 

Light. Using the drop down 

menus at top of screen, go to 

Window>Type>OpenType. With 

text selected, click the Stylistic 

Alternates button (2). Make certain 

that the type size and leading are 

proportional to this example. 

Stylistic Alternates button

Leading sizeFont size

1a.

1b. 2.

Creating the display font graphic isn't a complicated process 

but it is important to follow these rules to get it to look 

consistent as you introduce this treatment to other phrases. 

Adobe Illustrator should be used to create this graphic. 

How to create the 
display font graphic
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Step 5 

Place copy block on top of 

arrangement. Select entire grouping 

and with selection tool and create 

clipping mask (5). From the 

Object drop down menu, go to 

Object>Clipping Mask>Make.

Final 

Your display font graphic is complete.

5.

Step 3 

With text box selected, convert this 

copy block to paths. From the Type 

drop down menu, go to Type>Create 

Outlines (3). 

Step 4 

Continuing with the text box selected, 

release compound paths (4). From 

the Object drop down menu, go to 

Object>Compound Path>Release. 

Reselect all text with selection tool 

and remake the compound paths 

(4). From the Object drop down 

menu, go to Object>Compound 

Path>Make.

3. 4.



51

There are a series of illustrations and shapes that make up 

the look of the American Alliance of Museums. The colors 

shown can be changed to other brand colors (according to the 

guidelines) to fit your design.

Illustration assets

1. Corner piece #1 

These pieces sit in the top corners of layouts.

2. Swipe triangle 

These pieces are intended to sit at the bottom of a page to either 

accentuate the right side of the large banner (7) or should have 

an angled pin stripe protruding from it's top point. The pin stripe 

should follow the exact angle of the left side of the triangle.

3. Corner piece #2 

Another piece intended to sit in a corner.

4. Corner piece #3 

Yet another corner embellishment.

5. Weave arms 

These arms are inspired from the weave of the logo.

6. Pin stripe swipe & slice 

This piece can add a very slight and delicate accent to a stark 

white page. Text should not cross it's lines.

7. Large banner 

This banner was intended for large hero pages. Text should be 

placed with the horizontal area. The text should be weighted to 

the top-left of the live area. The left triangle area should bleed off 

of the bottom of the page and the pin stripe on the right should 

be extended to bleed off of the page as well.
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4.

2. 3.

1.

5.

6. 7.
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There are a variety of different illustrations and shapes that 

make up the look of the Alliance brand. It is important to use 

them correctly to maintain the look they are meant to evoke.

Usage of  
illustration assets

At quiderepre  
porpor sequia

Usage of large banner (7).
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Quiderepre
Ut eum lam, tem fugiasserum 

quia ditaspe ribusam sinimus 

que evenem ipsunt omnime 

nonsenimus, ut quunt ea vellatur, 

aut aligname eate velenti dolupta 

atur, apeliquam, sitatur aut que 

dendem volupienis exerchi ligendi 

samenihiciur antur, omnit

Ut eum lam, tem 

fugiasserum quia ditaspe 

ribusam sinimus que 

evenem ipsunt omnime 

nonsenimus, ut quunt 

ea vellatur, aut aligname 

eate velenti dolupta atur, 

apeliquam, sitatur aut 

que dendem volupienis 

exerchi ligendi samenihiciur 

antur, omnit

Quiderepre
Ut eum lam, tem fugiasserum 

quia ditaspe ribusam sinimus 

que evenem ipsunt omnime 

nonsenimus, ut quunt ea vellatur, 

aut aligname eate velenti dolupta 

atur, apeliquam, sitatur aut que 

dendem volupienis exerchi ligendi 

samenihiciur antur, omnit

Quiderepre

Usage of pin stripe swipe and slice (6). Usage of large banner (7), pin stripe swipe & slice (6), swipe triangle (2), 

and corner piece #2 (3).

Usage of corner piece #1 (1) 

and #2 (3).
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Avoiding overuse and over sizing of the illustration elements is 

the most important rule of thumb when using these pieces.

Misuse of 
illustration assets

At quiderepre  
porpor sequia

Do not rotate the large banner or put 

more than one on a page. Do not 

have corner pieces on same page as 

the large banner. Do not place corner 

pieces over an image.

At quiderepre  
porpor sequia



56

Quiderepre
Ut eum lam, tem fugiasserum 

quia ditaspe ribusam sinimus 

que evenem ipsunt omnime 

nonsenimus, ut quunt ea vellatur, 

aut aligname eate velenti dolupta 

atur, apeliquam, sitatur aut que 

dendem volupienis exerchi ligendi 

samenihiciur antur, omnit

Ut eum lam, tem 

fugiasserum quia ditaspe 

ribusam sinimus que 

evenem ipsunt omnime 

nonsenimus, ut quunt 

ea vellatur, aut aligname 

eate velenti dolupta atur, 

apeliquam, sitatur aut 

que dendem volupienis 

exerchi ligendi samenihiciur 

antur, omnit

Quiderepre

A maximum of 2 corner pieces 

should be used on a single page at 

a time. Corner pieces should never 

overlap the pin stripe swipe & slice. 

Corner pieces should only be used 

on corners that are along the same 

edge of the page.

Avoid overuse of the large banner. Never use them on adjacent pages. 

Layouts should avoid having full page floods that are not white, PMS 3165, 

or an image. Avoid butting warm and cool brand colors against  

each other.

Corner pieces should not be 

overly large. They should 

never extend further than 1/4 

of the way across the page.

56
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Our photography
A focus on people is at the core of the Alliance brand. Photos 

should feel warm, modern, spacious and emotional. 

Architectural photos should not be the center of attention. 

All featured photos are for demonstration purposes only.

Staff photography can look slightly more posed, but should have a relaxed 

portraiture feel. They should look authentic and optimistic. These 

photos should have rich colors with a soft focus.

Staff photography
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Architectural photography should 

appear in a textural context showcasing 

patterns and dramatic angles to 

reflect the brand's graphic language.

The goal of visitor photography is to convey a fun, engaging and interactive atmosphere. People 

should appear in groups to reinforce the support and togetherness aspects of the Alliance. People 

should not appear posed and should not be looking into the camera unless there is only one person 

in the shot. Colors should be bold and strong and not pale in order to match the treatment of the 

brand's color palette.

Architectural photography Visitor photography
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Photography that is flat and dull should be avoided. Stiff, posed 

subjects is not what the Alliance represents. 

Misuse of 
photography
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Architectural photography should not be 

flat and should contain some burst of 

bright, beautiful saturated color.

People photography should steer clear of being overly staged and posed. Avoid washed out 

backgrounds. Avoid photos of people staring at art on walls. Interactivity and engagement are 

key in the photography for the Alliance.

Misuse of architectural photography Misuse of people & staff photography

All featured photos are for demonstration purposes only.
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Collateral
 examples
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Putting it together
The graphic elements of the Alliance brand are a versatile 

collection of tools that can used across a myriad of collateral 

pieces. A selection of examples of commonly needed materials  

are included.

8.
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1. Flyer   2. Postcard   3. Tote bag   4. Sketch book    

5. Magazine ad   6. Membership card    7. Compact disk slip    

8. Letterhead, envelope, and business cards

3. 4.

6. 7.

1. 2.

5.
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